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Essential Excel in a Day 

 

Greetings, 

Thank you for picking up Essential Excel in a Day.  The objective of this programme is to provide you 
with the essential skills you will need to get up and running with Excel in just 1 day!  At the end of 
the programme, you will emerge an invaluable asset to your team. 

Excel is first and foremost, a database.  It is much more than a digital sheet of paper or a warehouse.  
It calculates, manipulates, processes and presents information to add value to your work and your 
life. 

Included are a lesson plan and a syllabus that will cover all the tools you will need as an everyday 
Excel operator.   

Excel is like a language and if not used regularly, becomes something that you vaguely remember, 
but cannot use in a practical manner.  If you or the audience you are intending to help don’t use 
Excel on a regular basis, please do not proceed any further – save yourself some time and do 
something you are more passionate about! 

However, if you are keen to develop yourself and do in minutes what others hope to accomplish in 
days, then you my friend are ready for Essential Excel in a Day!  
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Structure 

 

This programme will contain several modular lessons that can be learned in any order, though it is 
recommended that you start sequentially in the order in which they are presented.   

Each lesson will consist of the following parts: 

1. Overview 

The Overview will explain the purpose and function of the aspect of Excel presented. 

2. Walkthrough 

The Walkthrough will explain the working parts as they relate to the user. 

Final Project 

 

The Final Project at the end of the day will utilise a combination of the Excel functions  

covered in the course to assess the user’s ability to integrate functions to create working  

database spreadsheets.   

 

Remember, it is all right if you don’t get the answer the first time round – that’s what learning is.  
The important thing is to learn and understand so that Excel makes your life easier, not harder! 
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Recommended Lesson Plan 

 

Time Activity 

0900 – 1030 Lesson 1: Fundamentals 

1030 – 1100 Tea 

1100 – 1230 Lesson 2: Text and Text Functions 

1230 – 1330 Lunch 

1330 – 1430 Lesson 3: Mathematical Operations and Mathematical Functions 

1430 – 1500 Tea 

1500 – 1630 Lesson 4: Logical Functions 

1630 – 1700 Break 

1700 - 1830 Lesson 5: Data Processing 

1830 - 1930 Final Project 

 

*The recommended class size is 15 to ensure adequate guidance and attention to learners. 
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1. Lesson 1: Fundamentals 

1.1. Overview 

Excel is in its purest form, a database.  It is a program used to store numbers and text that are 
arranged and organized to serve a purpose.  Often, data needs a voice and as an Excel operator, 
you will be able to shape the stories that your data is meant to tell. 

Excel is akin to a sandbox and once you learn the tools you need, you will be able not just to 
process, but to create! 

1.2. Walkthrough 
 

1.2.1. Interface 

 

This screen shows the interface on Microsoft Excel 2007 – that’s the screen you start with.  
You can find out which version of Excel you are using by clicking on the ‘Office Button’, 
selecting ‘Excel Options’ and then selecting ‘Resources’.  The version of Excel will be in the 
line at the bottom. 
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1.2.1.1. Right-click – performing a right click with your mouse when pointing 
to a cell will open a menu of options like so.  Just keep this in mind as we will be 
using this command often.  

 

 

1.2.1.2. Undo – by pressing Ctrl + Z or the ‘Undo’ button, you may undo your 
recent changes to your spreadsheet.  Essential, as we will use this command 
often. 

 

 

1.2.1.3. Autofill 

1.2.1.3.1. Copying 

The Autofill is an amazing function used in Excel that copies data into the cells 
below the one you’ve selected.  Let’s try this out.  Type 1 in the cell A1. 
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Now, move your cursor to the bottom right edge of the cell A1.  You should see 
that your cursor changes into a bold +.  Now, perform a left-click and hold your 
mouse button down while moving your mouse downwards so that it selects the 
cells A1 to A9. Then release the mouse button. 

 

See that you have copied the number 1 from cell A1 into all the other cells down 
to cell A9? 
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1.2.1.3.2. Running numbers 

You can do this with running numbers as well.  Type 1 in cell A1 and 2 in cell A2.   

 

Now, highlight both cell A1 and A2 by performing a left-click on cell A1, then 
holding and moving your mouse downwards to cell A2. Then release the mouse.  
You will see that both cells are highlighted.  
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Now, move your mouse to the bottom right corner of cell A2 until your cursor 
changes into a bold +.  Now, perform a left-click and hold your mouse button 
down while moving your mouse downwards till it selects all the cells from cell A1 
to cell A9.  Then release the mouse button. 

 

Notice that without having to type the numbers manually, you have created a 
sequence of running numbers from 1 to 9 – by just typing 1 and 2!  

1.2.1.3.3. Days and Months 

You can do the same with days of the week or months.  Try typing ‘mon’ in cell 
A1. 
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Now, move your mouse to the bottom right corner of cell A1 until your cursor 
changes into a bold +.  Now, perform a left-click and hold your mouse button 
down while moving your mouse downwards till it selects all the cells from cell A1 
to cell A7.  Then release the mouse button. 

 

Notice that you have created a sequence of weekdays just by typing the word 
‘mon’! 

Let’s try this with months.  Type ‘jan’ in cell A1. 
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Now, move your mouse to the bottom right corner of cell A1 until your cursor 
changes into a bold +.  Now, perform a left-click and hold your mouse button 
down while moving your mouse downwards till it selects all the cells from cell A1 
to cell A12.  Then release the mouse button. 

 

You have created a sequence of months of the year, just by typing in the word 
‘jan’! 

1.2.1.3.4. Relative Autofill 
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The Autofill also detects if you are trying to fill in blank cells based on the column 
next to it. Let’s see how this works. 

Here, we have a column with the numbers from 1 to 21. 

 

Type in ‘mon’ in cell B1. 
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Now, move your mouse to the bottom right corner of cell B1 until your cursor 
changes into a bold +.  Now, perform a quick double left-click. 
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See that the autofill has automatically filled in the weekdays from Monday to 
Sunday, stopping at the last filled cell of column A?  Autofill.  Cool. 
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1.2.1.4. The ‘Office Button’ 

The ‘Office Button’ contains a variety of commands that you will use pertaining to the whole 
Excel file you are working on. 

 

 

1.2.1.4.1. ‘New’ – creates a new Excel file 

Click on ‘Blank Worksheet’ and then ‘Create’ to create a new Excel file.  
 

 

 

1.2.1.4.2. ‘Open’ – opens an existing Excel file which you will have to 
select from your computer.  A screen like this will appear.  You can select 
the file you wish to open and then click ‘Open’. 
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1.2.1.4.3. ‘Save’ – stores your Excel file onto your hard drive or the selected 
location.  A screen like this will appear.  You can type in the name you wish to 
call your Excel file in the field ‘File Name’ and then click on ‘Save’. 

 

 

 

 

1.2.1.4.4. ‘Save As’ – stores your Excel file, but also gives you the 
option to rename your file as something else or to save it in another format.  
Similar to ‘Save’ except that it will automatically prompt you to save the file 
in a different name. 

*Tip – the ‘.csv’ format appears to be the one which uses the least amount of memory. 
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1.2.1.4.5. ‘Print’ – allows you to print the Excel file. 

 

1.2.1.4.6. ‘Prepare’ – contains a list of options that pertain to the 
security of your file. 

 

1.2.1.4.6.1. ‘Properties’ – allows you to change the author 
details on your Excel file. 
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1.2.1.4.6.2. ‘Inspect’ – generates a report about the Excel file 
pertaining to the following issues: 

 

1.2.1.4.6.3. ‘Encrypt’ – allows you to place a password on your 
Excel file.  No one will be able to open the file without the right 
password! 

 

1.2.1.4.6.4. ‘Add a Digital Signature’ – allows you to add your 
very own digital signature for verification purposes.   

1.2.1.4.6.5. ‘Mark as Final’ – this saves the Excel file and 
thereafter disables all editing and saving.  Only use this when you are 
absolutely sure you do not want to make any updates or amendments 
to a file.  This is more of a safeguard to prevent tampering of a 
document. 

1.2.1.4.6.6. ‘Run Compatibility Checker’ – checks the current 
Excel file for features that may not have been implemented in earlier 
Excel versions.  This is useful when you have to send a file to someone 
who has an earlier version of Excel. 

 

1.2.1.4.7. ‘Publish’ – allows you to save your file onto a shared server. 
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1.2.1.5. The ‘Excel Options’ button 

 

There are a host of options to customise Excel within this menu, but we will not be using 
that in this programme.  The default parameters already in place more than serve our 
purposes when using Excel, so don’t worry! 
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1.2.1.6. Tabs and Categories 

 

Tabs - The interface displays several menus called ‘Tabs’. 

 

There are usually 7 of them: 

1.2.1.6.1. ‘Home’ – provides font, alignment functions and aesthetic 
functions like conditional formatting. 

1.2.1.6.2. ‘Insert’ – lists options more inclined to presentation like 
charts and pivot tables. 

1.2.1.6.3. ‘Page Layout’ – lists options for spreadsheet themes, 
margins and gridline views. 

1.2.1.6.4. ‘Formulas’ – lists options for inserting formulas into cells. 

1.2.1.6.5. ‘Data’ – lists options for data sorting and filtering as well as 
data validation or dropdown lists. 

1.2.1.6.6. ‘Review’ – provides options for password protection for the 
spreadsheet and for inserting comments into cells. 

1.2.1.6.7. ‘View’ – lists options for the way the spreadsheet is 
displayed and to freeze panes  

1.2.1.6.8. ‘Developer’- this is a more advanced tab that I like to keep 
on as it provides options for some pretty interesting stuff like buttons.  You 
can add this tab to your interface by choosing it from the ‘Excel Options’ 
menu. 

 

Category - Each tab contains several categories. 

These categories contain various options that you can select to apply to your Excel spreadsheet. 
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1.2.2. Cells and Spreadsheets 

 

Each Excel file is known as a ‘Workbook’, containing ‘Worksheets’ or spreadsheets, which in turn 
contain ‘Cells’.  You can see how many spreadsheets there are in your Excel workbook by looking 
at the tabs at the bottom of the screen. 

So, that makes for 3 spreadsheets! 

 

1.2.2.1. Cell Reference 

Think of the spreadsheet as a map and the cells as coordinates on that map.  The numerical 
labels on the left of the screen are called Row Labels and correspond to the Y-axis while the 
alphabetical labels on the top of the screen are called Column Labels and correspond to the X-
axis.  

Hence, whenever we name a cell according to its cell reference, it will always contain a letter 
and a number like A1 or Z4. 

The cell reference that you select is displayed on the top right of the screen. 

Cells are the building blocks of your Excel spreadsheet and may contain text, numbers or 
formulas. They can also be formatted to a different colour or display different fonts or 
alignment. 

 

1.2.2.2. Creating a new spreadsheet 

You can create a new spreadsheet by clicking on the ‘Create New Spreadsheet’ button that 
appears at the bottom of the screen. 
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1.2.2.3. Spreadsheet options 

You can also access a menu of options by performing a right click on any of the sheets in your 
workbook. 
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1.2.3. Formatting 

 

 

The majority of your formatting options; like changing fonts or the alignments of your data, will 
be found in the ‘Home’ tab within categories like ‘Font’ or ‘Alignment’. 

1.2.3.1. Fonts, Size and Colour 

This is the sample data that we will be using throughout this programme.  Let’s see if we can 
change the way the data looks by changing some fonts. 

Notice that with cell G2 currently selected (you can tell by the cell reference in the top right) and 
by selecting a different font, the number 7 automatically changes its look?  There are many fonts 
to choose from, so do try this one out! 

 

The size of the data can also be changed just as easily. 
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You can change the colour of the cell and the colour of the data as well.   

 

The button that looks like a paint bucket controls the colour of the cell while the button with the 
letter ‘A’ underlined by a coloured line controls the colour of the data. Clicking on the small 
dropdown arrows next to the icons brings up the menus.  See that we have made the cells 
yellow and the data red? 
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1.2.3.2. Alignment 

Let’s select the whole of column G now.  We can do this by moving the mouse to the column 
label G until you see a small black arrow pointing downwards.  Left clicking will now select the 
whole column, which will then be shaded in grey like so. 

 

Let’s change the alignment by clicking on the alignment buttons – they look like several small 
horizontal lines.  Notice that the alignment for column G has changed to a central alignment? 

Easy, yes? 

 

1.2.3.3. Format Cells 

 

Performing a right click while your cursor is on a cell will bring up a menu.  Select ‘Format Cells’.  
You will see an option box with 6 tabs, like this.  Notice that many of these options are similar to 
those found in the ‘Home’ tab in the ‘Fonts’ and ‘Alignment’ categories. 
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1.2.3.3.1. ‘Number’ – allows you to change the formatting of your 
data from plain numbers, to integers with decimal places, currency or even 
dates. 

 

1.2.3.3.2. ‘Alignment’ – allows you to change the flow of your data 
and their alignment – essentially changing their direction from top-down, 
down-up or even making them flow diagonally. 
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1.2.3.3.3. ‘Font’ – this list of options is similar to the ‘Font’ category in 
the ‘Home’ tab. 

 

1.2.3.3.4. ‘Border’ – provides options on giving your data borders – 
essentially lines bordering your cells in addition to the gridlines already 
visible. 
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1.2.3.3.5. ‘Fill’ – colour options for your cells. 

 

1.2.3.3.6. ‘Protection’- these options only come into effect when you 
have added protection to your worksheet.  This option is in the ‘Review’ 
tab, under the ‘Changes’ category, called ‘Protect Sheet’. 

1.2.3.3.6.1. ‘Locked’ locks the cells with the parameters you 
indicate when protecting the sheet. 

1.2.3.3.6.2. ‘Hidden’ hides the formulas in your cells when your 
worksheet is protected. 
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1.2.4. Writing formulas 

 

Formulas are statements that are entered into cells that process data.  If you are going to do 
anything worthwhile in Excel, it will definitely involve a formula of some kind.   

All formulas begin with an ‘=’ sign. 

The structures of formulas are basically the same.  You type an ‘=’, followed by an open ‘(‘, then 
the function name and end with a closed ‘)’. 

So, what is the difference between a formula and a function?   

A formula is a statement that processes data.  A function is a specific operator that is used 
within a formula.  As you will see later, a formula may contain many functions – but it is still just 
one formula. 

An example would be the following: 

=IF(AND(A2=1,D2="Pen"),"Team 1 sold a pen","Guess not.") 

Notice, the formula begins with an ‘=’, then the function IF and then an opening ‘(‘, ending with 
a closing ‘)’.  Notice that the function AND is also used in the formula.  This is an example of a 
formula containing 2 functions.   

You would have also noticed that all functions are in capitals, like IF and AND. 

When including a cell reference in a formula, you can use the comma sign to separate individual 
cell references, like: 

=COUNT(B1,B2,B3) 

Alternatively, you can just include them as a cell range reference like so: 

=COUNT(B1:B3) 

The ‘:’ means that all cells in between the first cell and last cell reference will be included in the 
formula. 

As you go along, you will get used to using 2 or more functions within a single formula.  Exciting. 

In time, you will also learn how formulas can be used to relate to each other to construct some 
sophisticated stuff! 
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1.2.5. Printing 

Printing warrants a section on its own due to the wide range of options available. To print, click on 
the Excel Button and then click on the right facing arrow to the right of ‘Print’. 

 

There are 3 options: 

1.2.5.1. ‘Print’ 

 

1.2.5.1.1. ‘Print Range’ allows you to specify if you want to print all the pages 
in your spreadsheet or just the a specified range. 

1.2.5.1.2. ‘Print what’ has some options too: 
1.2.5.1.2.1. ‘Selection’ prints any cell or cell range that you have selected by left 

clicking and dragging.   
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Notice that only the areas selected have been slated for printing and not the 
whole spreadsheet. 

.  

1.2.5.1.2.2. ‘Active Sheets’ prints all the pages on the spreadsheet you are 
currently in. 

1.2.5.1.2.3. ‘Entire workbook’ prints all pages from all spreadsheets in your 
workbook. 

1.2.5.2. ‘Quick Print’ – this prints the spreadsheet you are on immediately – I do not 
recommend this option for most print tasks. 

1.2.5.3. ‘Print Preview’ – this generates a preview of the output that is to be printed.   
I recommend always viewing a preview before confirming a print task. 

The parameters of a print task can be influenced using the ‘View’ tab.   

 

We will focus on the following options: 
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1.2.5.4. ‘Page Layout’ shows you how your data will be printed out. It’s similar to a 
print preview. 

 
 

1.2.5.5. ‘Page Break Preview’ allows you to set the boundaries of your data as they 
would be printed. 
 
Notice the text ‘Page 1’ in the centre of the data.  This indicates that this would 
be the 1st page that would be printed. 
 
The dotted line indicated by the green arrow is where the boundary of Page 1 
ends.  Anything to the right of this line would be printed on another sheet of 
paper. 
 
The solid blue line indicated by the red arrow marks the absolute end of your 
data.  Nothing will be printed to the right of this line. 
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You can change the boundary of the printout by clicking on and dragging the 
dotted blue line to the absolute border of your data, like so. 
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A display like this would indicate that all the data within the solid blue border 
would be printed as the 1st page of your printout. 
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1.2.6. Data Sample 

 

Let’s look at our data sample.  We will be working with this sample for the duration of our 
programme.  Our data sample is a database of the sales performance of 3 teams of 10 sales 
personnel each.  The data has 7 variables and a total of 91 rows, including the column headers: 

1.2.6.1. ‘Team’ – indicates the sales team the person is in.  There are 3 
teams, from Team 1 to Team 3. 

1.2.6.2. ‘Name’ – this is the name of the salesperson. 

1.2.6.3. ‘Date’ – this is the date the sale was made 

1.2.6.4. ‘Item’ – this is a record of the item type sold in that particular sale. 

1.2.6.5. ‘Unit Sales’ – this indicates the quantity of the item sold. 

1.2.6.6. ‘Unit Cost Price’ – this indicates the cost price of the unit sold. 

1.2.6.7. ‘Unit Sale Price’ – this indicates the sale price of the unit sold. 
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2. Lesson 2: Text and Text Functions 

2.1. Overview 

One third of the data you will deal with on a day to day basis will be in text. The other two-thirds will 
be in numbers and formulas, respectively.   

Knowing how to manage text will save you tonnes of hours and will make your work with data a 
whole lot easier!  We will be going through how to process and create text in your Excel 
spreadsheets as well as manage them with several useful functions. 

2.2. Walkthrough 

You can simply enter text into a cell by clicking on a cell with a double left click.  You will see a 
blinking text bar in the cell, like this. 

 

Now, press the ‘Enter’ key.  Notice that unlike in Word documents; where pressing the ‘Enter’ key 
creates another line below the text, in Excel, it merely moves the selection of the cell 1 cell 
downwards. 

 
2.2.1. Alt + Enter 

In order to create an additional line in the cell – technically making it larger by giving it an extra text 
line, perform a double left click on the cell and at the place you want to insert another line, press Alt 
+ Enter. 

This allows you to create paragraphs of text within a single cell. 
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Notice how another line has been added?  Now you can type in the text you want in the new line, 
like so. 

 

You can view the complete text in the cell contents box above by either clicking on and dragging the 
cell contents box’s border downwards, or using the scroll arrows on the extreme right of the cell 
contents box. 
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2.2.2. Text boxes 

Textboxes are objects that you can place in your spreadsheet that contain text. 

You can create a textbox by clicking on the ‘Insert’ tab and then selecting ‘Text Box’. 

 

Your cursor will transform into a crosshair.  Click and drag to position and size your text box within 
the spreadsheet.  Your text box will appear as you have shaped it! 

 

Now, you can freely type in anything you want into the text box. 
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mailto:excelpunks@gmail.com


Essential Excel in a Day! 

 

Get in touch at excelpunks@gmail.com!  Page 44 

 

 
2.2.3. CONCATENATE 

Example spreadsheet CONCATENATE.xlsx is included in the folder Lesson 2. 

CONCATENATE is a function that combines text together.  It can also be used to combine numbers 
too.  Remember that when combining numbers, it doesn’t add them up, it merely places them 
together.  We’ll see how this works. 

Let’s look at our data sample. 

2.2.3.1. Text 

If we wanted to combine Adrian Tate’s name with the item Pen, we’d use the following formula: 

=CONCATENATE(B2,D2) 

 

Notice the structure of the formula.  We start with an ‘=’ sign and then an open ‘(‘.  The function 
CONCATENATE comes next. 

Then we can select cells that we want to combine together.  Remember that when selecting an 
additional cell, we place a ‘,’ between them.  So our formula gets us the following result: 

 

You can also specify customized text when you use CONCATENATE.   

If you wanted to include the phrase ‘has sold the item’ between the name and the item of a 
salesperson, you can do that too.  Here’s how: 

=CONCATENATE(B2," has sold the item ",D2) 
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See that we have now included an entire phrase between the contents of 2 cells?   

The only difference between this and the first formula is that we have included custom text.  
Remember that when including text in a formula, make sure that the text is within an opening “ and 
a closing “. 

Notice also that spaces within the “ and “ are included into our phrase, creating a space before and 
after our custom text.   

2.2.3.2. Numerical 

We can also combine numbers together.  So let’s combine the numbers of ‘Unit Sales’ and ‘Unit Cost 
Price’ together. 

=CONCATENATE(E2,F2)  

Notice that the numbers 9 and 5 have been put together to make 95?  Remember that 
CONCATENATE only places the numbers or text side by side and does not add them up. 

 

2.2.3.3. Sentences 

Now, let’s make a sentence.  Let’s make a sentence combining all the variables from the record for 
Adrian Tate.  Here’s how: 

=CONCATENATE(B2," from ","Team ",A2," sold ",E2," ",D2,"/s on ",TEXT(C2,"dd/mmm/yy")," of cost 
price $",F2," for $",G2,".") 

We get: 
Adrian Tate from Team 1 sold 9 Pen/s on 12/Jan/14 of cost price $5 for $7. 
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See that all custom text, including spaces, periods and $ are contained within their own opening and 
closing “? 

For dates, it’s a little more complicated.  Notice this part of the formula? 

TEXT(C2,"dd/mmm/yy") 

Well, this essentially tells Excel to convert the contents of C2, which are dates, into text format and 
to format them in the DayDay/MonthMonthMonth/YearYear format. You can change the way the 
days, months and years are ordered if you want. 
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2.2.4. TRIM 

Example spreadsheet TRIM.xlsx is included in the folder Lesson 2. 

TRIM is an interesting function when you are dealing with lots of data that has been pre-formatted.  
It could be data downloaded from another system or something a research lab has generated.  What 
TRIM does is it cuts away all spaces before and after the data, to ensure that only data like numbers 
or text are retained. 

Here’s an example: 

 

Notice that there is a noticeable spacing of 5 spaces immediately after the name ‘Adrian Tate’?  This 
can sometimes occur when downloading data from a foreign source.  Excel identifies these 5 spaces 
as a part of the cell contents, meaning that it doesn’t read cell J2 as ‘Adrian Tate’, it reads cell J2 as 
‘Adrian Tate     ‘. Yes, with the 5 spaces included. 

TRIM gets rid of spaces before and after the contents of a cell like so: 

=TRIM(J2) 

This gives us ‘Adrian Tate’, instead of ‘Adrian Tate     ‘. 
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2.2.5. LEFT/RIGHT 

Example spreadsheet LEFT and RIGHT.xlsx is included in the folder Lesson 2. 

LEFT and RIGHT are character editing functions that take a specified number of characters; be they 
numbers or letters, from the left or right of a cell’s contents.  They are used mainly to separate the 
contents of a cell like last names from full names. 

Here’s an example: 

=LEFT(B2,6) 

 

Notice that LEFT used in this manner, gives us 6 characters counting from the left of the cell contents 
of B2.  So, we can get the name ‘Adrian’, cut from his full name of ‘Adrian Tate’. 

We can do similar thing with the RIGHT function: 

=RIGHT(B2,4) 

 

Notice that RIGHT used in this manner gives us 4 characters counting from the right from the cell 
contents of B2, giving us ‘Tate’ from ‘Adrian Tate’. 
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2.2.6. LEN 

Example spreadsheet LEN.xlsx is included in the folder Lesson 2. 

LEN is a character counting function that counts the number of characters or length of the contents 
within a cell.  Here’s an example: 

=LEN(B2) 

 

LEN when used in this manner, counts the number of characters in the cell B2, containing the text 
‘Adrian Tate’.  Notice that the space between ‘Adrian’ and ‘Tate’ is counted as well, giving a length of 
11 even though there are only 10 letters in the name. 

LEN can be used in combination with LEFT or RIGHT in order to take away instead of include 
characters from a cell.   

Here’s an example: 

=LEFT(B2,LEN(B2)-4) 

 

Here, we have used the LEFT and LEN functions to give us all the characters starting from the left, 
except the last 4. 

You can observe the structure: 

=LEFT(B2, - retain all the characters starting from the left in cell B2 

LEN(B2)-4) – subtracting characters of length 4 from the end 

This is a little abstract and is mainly used when you want to separate text strings that have a 
common number of characters at the start or end that are used as identifiers. 
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2.2.7. DAY/MONTH/YEAR 

Example spreadsheet Date.xlsx is included in the folder Lesson 2. 

Date functions give you the DATE of the month, MONTH of the year or just the YEAR from a cell with 
a date within it.  Here are examples: 

=DAY(C2) 

=MONTH(C2) 

=YEAR(C2) 

 

Notice that the functions return the component parts of the date in the form of numbers from cell 
C2, which contains the date 12-Jan-14. 

For MONTH, the number returned corresponds to the month of the year, with 1 being January, 2 
being February and so on. 
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2.2.8. WILDCARD 

Example spreadsheet Wildcard.xlsx is included in the folder Lesson 2. 

A wildcard is called up by the ‘*’ to tell Excel that any number of characters may appear before or 
after a specified character.  This is often used in conjunction with logical formulas like COUNTIF and 
SUMIF.  

Here’s an example: 

=COUNTIF(B2:B21,"Adrian*") 

 

Don’t worry about the COUNTIF function, just focus on the way that the “*” has been used.   

In this function, we used the COUNTIF function to count the number of names within range B2 to 
B21 that have the word “Adrian” in it, followed by any character, symbolized by the “*”.  Thus, we 
get the number 2, as there are 2 Adrians in our list, “Adrian Tate” and “Adrian Van Damme”. 

The wildcard can be placed before, after or even in between a specified character string. 

Here’s another example: 

=COUNTIF(B2:B21,"*Tate") 
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Notice that because of where we have placed the wildcard, we have counted the number of times 
the last name “Tate” appears in the cell range B2 to B21. 

As a final note, the wildcard functions DO NOT work with the IF function.  They work well with 
COUNTIF, SUMIF, AVERAGEIF and their plural variants. 
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2.2.9. Text to Columns 

Text to columns is an amazing function, especially if you work with a lot of text.  What it does is 
separate text into single words. 

Tip: This is especially useful if data like names have been typed into 1 cell each and you are trying to 
separate first and last names. 

Here, we’ve copied the name ‘Adrian Tate’ into cell J2. 

 

Now, with the cell J2 still selected, click on the ‘Data’ tab and select ‘Text to Columns’. 

 

The following option box will appear.  You may also see this when opening ‘.csv’ files.  They operate 
in the same way. 

You will see 2 options, ‘Delimited’ and ‘Fixed Width’.  Let’s go through them. 
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‘Delimited’ – this allows you to select how you want your text to be separated.  By clicking on ‘Next’, 
you will be brought to another option box. 

 

You can separate your text by ‘Tab’, ‘Semicolon’, ‘Comma’, ‘Space’ or any other method by which 
EACH word is already separated in your data. 

This means that if you have a line of text in 1 cell that is separated by commas, like, ‘a,b,c,d,e’, then 
by checking the ‘Comma’ box, your text will be separated into 5 columns from ‘a’ to ‘e’. 
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The text ‘Adrian Tate’ is separated by 1 space, so we can click on ‘Space’ and uncheck the ‘Tab’ box. 

 

Notice that a line has appeared in between the words.  This is how they will be separated. 
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Click on ‘Next’ and then ‘Finish’. 

 

Now, we see that the name ‘Adrian Tate’ has been separated into 2 columns, with the word ‘Adrian’ 
in one and ‘Tate’ in another. 
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‘Fixed Width’ – works in a similar fashion to ‘Delimited’ except it AUTOMATICALLY separates text 
with spaces in between them.   

 

‘Fixed Width’ allows you to specify how you would like your data to be separated in terms of the text 
width of your data. 
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Clicking on a part of the white area will create a break in the data at that point. Right now, we don’t 
need to do that. 

Click ‘Next’ and then ‘Finish’, 
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Just like in the ‘Delimited’ option, see that the name ‘Adrian Tate’ has now been separated into 2 
columns containing 1 word each.  Cool. 
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3. Lesson 3: Mathematical Operations and Mathematical Functions 

3.1. Overview 

Many would think that Excel exists primarily as a calculator. That is in fact, true, but that would also 
be to say that humans exist to procreate.  True, as well, but as we all know, both are meant for so 
much more! 

Here, we are going to explore functions that process the other 1/3 of data that we normally see in 
Excel. These mathematical functions will help you process data in a jiffy. 

3.2. Walkthrough 

 
3.2.1. Mathematical operators (+,-,*,/,>,<,=) 

Example spreadsheet Operators.xlsx is included in the folder Lesson 3. 

Mathematical operators are straight forward.  Remember that as these operators still make up part 
of a formula, we start any such formula with a “=”. 

3.2.1.1. Addition is symbolised by the “+” 

3.2.1.2. Subtraction is symbolised by the “-“ 

3.2.1.3. Multiplication is symbolised by the “*” (note that this is different 
from the  

wildcard in that it does not appear within opening and closing “s in the 
formula.) 

3.2.1.4. Division is symbolised by the “/” 

3.2.1.5. Greater than is symbolised by the “>” appearing after a number 

3.2.1.6. Greater than or equal to is symbolised by the “>=” appearing after a  

number 

3.2.1.7. Lesser than is symbolised by the “<” appearing after a number 

3.2.1.8. Lesser than or equal to is symbolised by the “<=” appearing after a 
number 

 

Here’s an example: 

=1+2 
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Simple enough.  Mathematical operators can also be used to process the contents of cells just be 
clicking on them as well. 

Here’s an example: 

=F2+G2 

The contents of cell F2 and G2 are the numbers 5 and 7, respectively, adding up to make 12. 
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3.2.2. COUNT/COUNTA 

Example spreadsheet COUNT and COUNTA.xlsx is included in the folder Lesson 3. 

The COUNT function counts the number of cells that contain numbers exclusively in them.  COUNTA 
counts the number of cells that contain either numbers or alphabets in them. 

Here’s an example: 

=COUNT(B2:B11) 

 

Here, we’ve counted the number of cells that contain solely numbers in them in the cell range B2 to 
B11. As you can see, we get the number 0. 

How about COUNTA? 

=COUNTA(B2:B11) 
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Using COUNTA with the same range variable, we see that the function has counted 10 cells that 
contain either numbers or letters in them. 

Since B2 to B11 only contains letters, how about a list of numbers? 

Here’s an example: 

=COUNT(E1:E11) 

Notice that we use cell range E1 to E11, that includes a list of numbers AS WELL AS their title, which 
is in text.   

 

Using COUNT with a cell range of E1 to E11, that contains a list of numbers and their title in text, we 
see that we get the number 10.  This means that only 10 cells – cells that contain numbers, were 
counted.  The cell containing the title in text was left out. 

How about COUNTA? 

=COUNTA(E1:E11) 

 

Here we see that by using COUNTA with the same range variable, we get the value of 11.  This 
means that cells containing either text or numbers were counted. 
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3.2.3. SUM 

Example spreadsheet SUM.xlsx is included in the folder Lesson 3. 

SUM deals explicitly with the addition of numbers. 

Here’s an example of when we try to add text together: 

=SUM(B2:B11) 

 

We expected a 0 didn’t we? 

Here we’ll add the numerical contents in cell range E2 to E11: 

=SUM(E2:E11) 

We get the result of 93. 
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3.2.4. AVERAGE 

Example spreadsheet AVERAGE.xlsx is included in the folder Lesson 3. 

AVERAGE computes the means or averages of a range of numbers. 

Here’s an example: 

=AVERAGE(E2:E11) 

Here we get the result of the average of the 10 cells, which is 9.3. 
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3.2.5. COUNTIF/COUNTIFS 

Example spreadsheet COUNTIF.xlsx is included in the folder Lesson 3. 

COUNTIF and its plural variant COUNTIFS, counts the number of cells according to criteria that you 
set. 

3.2.5.1. Text 

COUNTIF and COUNTIFS can be used with a text criterion. 

Here’s an example: 

=COUNTIF(D1:D21,"Pen") 

Using COUNTIF, we search the cell contents of cell range D1 to D21 for the word “Pen”. The result of 
which is 3.  Remember that when specifying text within a formula, the word must be framed by 
opening and closing “s. 

 

COUNTIFS can be used in a similar fashion: 

=COUNTIFS(B2:B21,"Ch*",D2:D21,"Shoes") 
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Used in conjunction with a wildcard function, we have used the COUNTIFS function to find the 
number of records that have a sales person’s name beginning with “Ch” from cell range B2 to B21 
and a sale item transacted corresponding with “Shoes” from cell range D2 to D21, with our answer 
being 2. 

3.2.5.2. Numerical 

Here’s a numerical example: 

=COUNTIF(A2:A21,1) 
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COUNTIF now looks at the cell range A2 to A21 and will only count the number of cells that contain 
the number 1.  The answer to that being 10.  

COUNTIFS works in a similar fashion, except that now you can specify more than 1 criterion.  Here’s 
an example: 

=COUNTIFS(E2:E21,9,A2:A21,1) 
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Here, we have applied COUNTIFS to look at cell range E2 to E21 and to count only cells that contain 
the number 9, IN ADDITION to the added criteria of the cell range A2 to A21 containing the number 
1.  In essence, we want to count the instances where someone from Team 1 has made a 9 item sale. 

Our answer is 1.   

Note that even though Team 2 was included in our cell reference, the criteria of cell range A2 to A21 
being 1 excluded Team 2 from the count. 

Notice that the while the columns in the cell references from the 2 ranges specified (columns A and 
E) may be different, the rows (rows 2 to 21) in the cell references must be identical, otherwise the 
formula would return an error. 

 

3.2.5.3. Logical 

What if you wanted to incorporate logical features in your COUNTIF?  How about we try counting all 
the ‘Unit Sales’ from Team 1 that are above 10? 

Here’s an example: 

=COUNTIF(E2:E11,">"&10) 

Let’s examine the structure of this formula. 

=COUNTIF(E2:E11, - applies COUNTIF to cell range E2 to E11  

“>”&10) – applies a logical aspect to the function through a mathematical operator >, which is 
framed by opening and closing “.  The mathematical operator is then applied to the number with an 
accompanying & symbol. 

 

The result from our COUNTIF formula is 3. 

As you can see, COUNTIF/COUNTIFS is a useful tool when processing large amounts of data. 
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3.2.6. SUMIF/ SUMIFS 

Example spreadsheet SUMIF.xlsx is included in the folder Lesson 3. 

SUMIF and its plural variant SUMIFS sums up the values in cell containing numbers according to 
criteria you set.  Like the COUNTIF function, your criteria can be numerical, alphabetical or logical. 

3.2.6.1. Text 

Here’s a text example: 

=SUMIF(B2:B21,"B*",E2:E21) 

Let’s examine this formula. 

=SUMIF(B2:B21,"B*", - checks cell range B2 to B21 for any name that starts with the letter B 

E2:E21) - adds up corresponding sales numbers from records that were transacted by a sales person 
with a name starting with the letter B.   

As we can see, 3 sales staff have names starting with the letter B and their sales numbers have been 
added up, giving us a result of 32. 

 

SUMIFS allows us to specify more than 1 criterion.  Here’s an example: 

=SUMIFS(E2:E21,D2:D21,"Trousers",B2:B21,"*Steinberg") 

The structure of the SUMIFS function is a little different from the SUMIF function.  SUMIFS requires 
the range of cells that you want to add up first, followed by the ranges where you specify criteria. 

mailto:excelpunks@gmail.com


Essential Excel in a Day! 

 

Get in touch at excelpunks@gmail.com!  Page 71 

 

SUMIFS thus sums up the values in cell range E2 to E21, based on whether the corresponding item 
from cell range D2 to D21 is “Trousers” and whether the sales person’s name ended with the last 
name “Steinberg”. 

Our result here is 13. 

 

 

3.2.6.2. Numerical and Logical 

Let’s say we wanted to find out the amount of trousers sold by Team 2 where each sale was for 
more than 8 pairs of trousers. 

Here’s how, using SUMIFS with numerical, alphabetical and logical criteria: 

=SUMIFS(E2:E21,A2:A21,2,D2:D21,"Trousers",E2:E21,">"&8) 

Here, we are adding up the values in cell range E2 to E21, based on whether their corresponding 
value in cell range A2 to A21 is equal to 2 (for Team 2), the item in cell range D2 to D21 is “Trousers” 
and whether the amount sold in cell range E2 to E21 is more than 8, our result being 24. 
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SUMIF and SUMIFS thus allows for complex calculations that save you time and allow you to specify 
multiple conditions for your data. 
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3.2.7. AVERAGEIF/AVERAGEIFS 

Example spreadsheet AVERAGEIF.xlsx is included in the folder Lesson 3. 

AVERAGEIF and its plural variant AVERAGEIFS calculates the averages or means of values in a cell 
range containing numbers according to criteria you set.   

They work like SUMIF and SUMIFS in the order that the function is structured.   

3.2.7.1. Text 

Here’s an example: 

=AVERAGEIF(B2:B21,"*Tate",E2:E21) 

Here, we have applied AVERAGEIF to find the average of sales from cell range E2 to E21, for all sales 
personnel with the last name of “Tate”, in conjunction with a wildcard function. 

Our answer, is 12, being the average of both sales figures of 9 and 15. 

 

Here is an example using AVERAGIFS: 

=AVERAGEIFS(E2:E21,B2:B21,"B*",D2:D21,"T-Shirt") 

Here, we have applied AVERAGEIFS to find the average sales of sales persons from cell range B2 to 
B21 with names starting with B and who have sold T-shirts (from cell D2 to D21). 

Our result is 9.5. 
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3.2.8. Numerical and Logical  

Let’s find the average sales from Team 1 that are more than 10 with a unit cost price of 10. 

=AVERAGEIFS(E2:E11,E2:E11,">"&10,F2:F11,10) 

Here we apply AVERAGIFS to find the average sales of Team 1 sales persons, from cell range E2 to 
E11 that are more than 10 with a unit cost price of 10,from cell range F2 to F11.  As there is only one 
such record that matches all the criteria, our answer is 14. 
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3.2.9. MIN/MAX 

Example spreadsheet MIN and MAX.xlsx is included in the folder Lesson 3. 

MIN finds the smallest number in a range and MAX finds the largest number in a range. 

Here are examples of how they are used: 

=MIN(E2:E11) 

By applying MIN to the cell range E2 to E11, we find that the smallest number in this range is 3. 

 

=MAX(E2:E11) 

By applying MAX to the cell range E2 to E11, we find that the smallest number in this range is 14. 
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3.2.10. SMALL/LARGE 

Example spreadsheet SMALL and LARGE.xlsx is included in the folder Lesson 3. 

SMALL finds a number from smallest to largest or in ascending order, in terms of rank, that you 
specify.  LARGE finds a number from the largest to the smallest, or in descending order, in terms of 
rank, that you specify. 

When using SMALL or LARGE, do remember that it RANKS all the numbers.  This means that if you 
have 5 numbers, 1,2,3,4 and 4, even though 4 is repeated twice, it will be assigned a rank – in this 
case, rank 4 and rank 5. 

Here are examples: 

=SMALL(E2:E11,2) 

Here, SMALL finds the 2nd smallest number in the cell range E2 to E11, which is 4. 

 

=LARGE(E2:E11,3) 

Here, LARGE finds the 3rd largest number in the range E2 to E11, which is 13.  As mentioned earlier, 
do notice that even though 14 is the largest number and is repeated twice, it is ranked as the 1st and 
2nd largest numbers, with 13 being the 3rd largest number. 
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4. Lesson 4: Logical and Reference Functions 

4.1. Overview 

Logical functions are like the higher level processes of the human mind.  They help to make sense of 
raw data and give that data a voice.  Data that talks back, so to speak. 

We will be learning a handful of helpful logical functions that will give your data a mind of its own!  

4.2. Walkthrough 

 
4.2.1. IF 

Example spreadsheet IF.xlsx is included in the folder Lesson 4. 

IF checks whether a logical argument that you specify is true or false. You also get to specify how IF 
is going to respond to each outcome, whether true or false. 

Think of this in the following terms: 

IF X is TRUE, the outcome will be Y, Z being the outcome if X is false. 

4.2.1.1. Text 

Here’s an example of what I mean: 

=IF(B2="Adrian Tate","His name is Adrian Tate.","His Name is NOT Adrian Tate.") 

Let’s examine the structure of this formula. 

=IF(B2="Adrian Tate", - IF is applied to cell B2 to determine if its contents is the name Adrian Tate  

"His name is Adrian Tate.","His Name is NOT Adrian Tate.") – if the contents of the cell is the name 
Adrian Tate, the formula gives you the sentence, "His name is Adrian Tate.".  If the contents of the 
cell ARE NOT the name Adrian Tate, the formula gives you the sentence, "His Name is NOT Adrian 
Tate." 

So we see that when the formula is applied to cell B2, the result is "His name is Adrian Tate." 

When the formula is applied to cell B3, the result is "His Name is NOT Adrian Tate.", as obviously, the 
name of the person is Brian Smith. 
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Again, the IF function checks if a statement that you specify is true and then you have to specify 2 
results, the 1st based on whether the statement is TRUE and the 2nd based on whether the statement 
is false. 

4.2.1.2. Numerical 

Let’s try this with a numerical aspect: 

=IF(E2>9,1,2) 

For this formula, we have applied the IF function to determine if the value in cell E2 is more than 9.  
If E2 is more than 9, the formula gives us the value of 1.  If E2 is 9 or less, the formula gives us the 
value of 2.   

So, we see that when the formula is applied to cell E2, the result is the number 2, as the value of cell 
E2 is 9 or less. 

When the same formula is applied to cell E3, the result is the number 1, as the value of the cell E3 is 
14 and is more than 9. 

 

Now, remember that the results that you specify the formula to give you are completely arbitrary.  
You can tell the formula to give you a letter, number or even do another set of calculations if you 
wanted to. 
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4.2.2. AND 

Example spreadsheet AND.xlsx is included in the folder Lesson 4. 

AND checks on whether one or more arguments that you specify is true or false and returns the 
value TRUE if all arguments are true and FALSE if not all the arguments are true. 

4.2.2.1. Text 

Here’s a text example: 

=AND(A2=1,B2="Adrian Tate",D2="Pen") 

Notice that the AND function only asks that you specify logical tests.  We’ve applied AND to cell A2 
to check if the cell contains the value 1, to cell B2 to check if the cell contains the name Adrian Tate 
and to cell D2 to check if the cell contains the item Pen.   

AND checks all three statements and if ALL are true, the formula gives us the word TRUE.  If at least 
one of the statements is false, the formula gives us the word FALSE. 

We can see this difference when the same formula is applied to cell B3.  B3 only satisfies one of the 
criteria we have stated, that being that the cell A3 contains the value 1.  As the other 2 criterion are 
not met, the formula gives us the word FALSE. 

This is known as a Boolean data option, where the result is either TRUE or FALSE. 
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4.2.3. OR 

Example spreadsheet OR.xlsx is included in the folder Lesson 4. 

OR checks on whether ANY of the arguments that you have specified are true.  OR returns the value 
TRUE if just one of the arguments is true and FALSE only if ALL the arguments are false. 

Here’s an example: 

=OR(A2=1,D2="Pen") 

Here we have applied the OR function to cell A2 to check if the contents of the cell is the value 1 and 
to cell D2 to check if the contents of the cell is the item Pen.  Our answer is TRUE as both of the 
criterion have been met.  Fine and good.  

 

 Here’s another example: 

=OR(A2=2,D2="Pen") 

Here we see that only one of the criterion has been met, that the contents of cell D2 is the item Pen.  
Cell A2 contains the value 1, so A2=2 is false.  This demonstrates that the OR function will return the 
value TRUE so long as at least 1 of the criterion has been met. 

 

The last example will show the only circumstance where OR will return the value FALSE, that being 
when ALL criteria have NOT been met: 

=OR(A2=2,D2="T-Shirt") 
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Here when we apply OR to cell A2, we know that cell A2 contains the value 1, so A2=2 has not been 
met.  We also know that cell D2 contains the item Pen, so D2=”T-Shirt” has failed the test as well. 

Hence, our answer is FALSE. 
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4.2.4. ISTEXT 

ISTEXT checks if the contents of a cell are exclusively text.  The cell would then return a value of 
TRUE or FALSE depending on whether the cell’s contents are exclusively text or not.  Here’s an 
example: 

=ISTEXT(B2) 

Here, we check to see if the contents of cell B2 are exclusively text.  As it only contains the text 
‘Adrian Tate’, the formula gives us the value TRUE. 
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4.2.5. ISNUMBER 

ISNUMBER checks if the contents of a cell are exclusively numerical.  The cell would then return a 
value of TRUE or FALSE depending on whether the cell’s contents are exclusively numerical or not.  
Here’s an example: 

=ISNUMBER(E2) 

Here, we check to see if the contents of cell E2 are exclusively numerical.  As it only contains the 
number 9, the formula gives us the value TRUE. 
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4.2.6. IFERROR 

Example spreadsheet IFERROR.xlsx is included in the folder Lesson 4. 

IFERROR is a special function that can be added on to any other function.  The primary purpose of 
IFERROR is to give a result should the initial function return an incomputable value or an error. 

Here’s an example: 

=A2+B2 

Now, we know that the contents of cell A2 is a number and that the contents of cell B2 contain 
letters.  As the mathematical operator + cannot add numbers and letters together, we get an error 
message, #VALUE. 

Bummer. 

 

By applying IFERROR, we are going to tell Excel to give us a different result instead of the error 
message, like so: 

=IFERROR(A2+B2,"Numbers and Letters cannot be added up.") 

As the result of A2 + B2 gives us an error message, IFERROR converts that message instantly to the 
text we have programmed, “Numbers and Letters cannot be added up." 
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4.2.7. VLOOKUP 

Example spreadsheet VLOOKUP.xlsx is included in the folder Lesson 4. 

Here we have one of the most powerful functions in Excel. VLOOKUP is a cross-referencing function 
that allows you to correlate items on a list.  VLOOKUP can be programmed to give you values in the 
same row as your cross-referenced item. 

Let’s find the unit sales of a name that we specify. 

Here’s how: 

=VLOOKUP(J2,B:E,4,FALSE) 

Let’s examine this formula: 

=VLOOKUP(J2, - VLOOKUP is applied to cell J2 which contains the name Christopher Jones.  This 
means that we are going to use the name Christopher Jones and compare it with the contents of the 
list we are going to mention next. 

B:E, - we have selected the whole of columns B to E.  In this case, as we have selected columns B to 
E, B is our relative 1st column, C is our 2nd column, D is our 3rd column and E is our 4th column.   

This is the list we are using the compare Christopher Jones’ name with.  When we specify this range, 
we are telling VLOOKUP to check if the name Christopher Jones is contained in this list’s 1st column, 
which is column B and to give us the value in the same row from the list’s relative column – that we 
will specify next. 

4, - we have indicated 4.  This tells VLOOKUP to give us the value in the same row as the name 
Christopher Jones from the list B:E’s relative 4th column.  This is column E.  As you can see, the 
number in the same row, but in the relative 4th column of list B:E is 14.  

FALSE) – this tells VLOOKUP that we want the name Christopher Jones to be matched EXACTLY, 
letter for letter.  You can also specify TRUE, but this will give you approximate matches.  We usually 
do not want this. 

So we see here that VLOOKUP looked through the whole of columns B to E, looking for the name 
Christopher Jones in column B (our relative 1st column) and then giving us the value in the same row 
as the name Christopher Jones from the relative 4th column of list B:E,  which is 14. 

*Remember that VLOOKUP has limitations.  If the name you are using appears more than once in 
the specified list, VLOOKUP only returns the 1st value. 
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Here’s another example, let’s try to find the unit sales price of the items sold by Christopher Jones: 

=VLOOKUP(J2,B:G,6,FALSE) 

Here we have applied VLOOKUP to the cell J2, containing the name Christopher Jones and to 
compare that with our list from columns B to 6 and returning us the number in the same row but 
from the relative 6th column of our list.  This being the number 21. 
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5. Lesson 5: Data Processing 

5.1. Overview 

Here we will be going through some of the more abstract functions of Excel.  As you gain more 
experience and become more proficient in Excel, these tools act as shortcuts to some potentially 
time-consuming operations! 

5.2. Walkthrough 

 
5.2.1. Pivot Tables 

Example spreadsheet Pivot Table.xlsx is included in the folder Lesson 5. 

A pivot table essentially summarizes and computes your data from a list automatically.  It will take 
some time to learn its aspects, but it will be worth the effort!   

Let’s apply a pivot table to our data sample. 

First off, select the ‘Insert’ tab and click on ‘Pivot Table’. Then select ‘Pivot Table’ again. 

 

This option box will appear.  
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Let’s go through the options you have here.  Your input in these option fields will determine the 
boundary and the location of your pivot table. 

5.2.1.1. ‘Select a table or range’ – this is where you input the cell range that 
encompasses your entire listing.  You can select exact cell range references or 
you can select entire columns (which is much easier). 

5.2.1.2. ‘Use an external data source’ – this connects you to another Excel file 
5.2.1.3. ‘New Worksheet’ – selecting this option will place your pivot table onto a 

new worksheet that will be instantly created for you. 
5.2.1.4. ‘Existing Worksheet’ – allows you to place your pivot table onto an already 

existing worksheet.  You just have to specify the cell reference that you want it to 
be in. 

Normally, if there is data on your spreadsheet when you select the pivot table command, it will 
automatically assume that that is the range you want for your pivot table.  In our case, this is true. 

Notice the range indicated in the field: 

=Sheet1!$A$1:$G$91 

This is the exact cell range reference for all the data in our table. 
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Now, let’s select ‘Existing Worksheet’ and in the ‘Location’ field, just click on cell J2.  It should look 
like this. 

 

Click ‘OK’. 

I know, it looks like a lot, but it will get easier as we go along. 
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Now, a box titled ‘Pivot Table 1’ will appear.  This is where our pivot table will display its information. 

 

You will also see a menu on the right that is split into 5 boxes: 

• ‘Choose Fields to add to report’ – allows you to customise the data fields you want inside 
your pivot table.  You can select them by left-clicking on the field name, holding and then 
dragging the field name to one of the 4 boxes below. 

• ‘Report Filter’ – dragging field names into this box creates a menu with the field names 
you’ve selected.  Remember that no data will be presented here except the qualitative 
categories of your field names. 
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• ‘Column Labels’ – presents categorical data from field names placed here in a column 
format, from left to right. 

• ‘Row Labels’ – presents categorical data from the field names placed here in a row format, 
from top down. 

• ‘Values’ – computes values from the field names placed here. It is important to place field 
names here if you want any computation done on your data and to appear in your pivot 
table. 

 

Notice that the column headers of all our 7 columns from the data sample have been transferred to 
the box titled ‘PivotTable Field List’?  That’s what Excel automatically does when you create a pivot 
table.  Excel automatically takes the column headers for your information and assumes it to be their 
title groups. 

Let’s move all the 3 fields, ‘Team’, ‘Name’ and ‘Item’ into the ‘Report Filter’ box to see what it does: 

We see that the data field titles have now been created on the spreadsheet and that dropdown 
arrows appear on their right. 
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Let’s select Team 1, Adrian Tate and Pen, from all the dropdown lists, respectively.  You can do this 
by clicking on the dropdown arrow next to the list, selecting an option and clicking ‘OK’. 
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You should now see that the dropdown lists now feature the values ‘1’, ‘Adrian Tate’ and ‘Pen’. 

 

But, there’s no data.  As it should be.  The ‘Report Filter’ box sets all the data fields dragged into it as 
filter options – meaning that it is only a menu of options. 

Data is only displayed when you move data fields into the ‘Column Labels’, ‘Row Labels’ or ‘Values’ 
boxes. 

Let’s try ‘Column Labels’ first.  Move the field ‘Unit Sales’ into the ‘Column Labels’ box.  Notice that 
the value 9 has appeared.  Looking at the data sample, this is the number of unit sales that Adrian 
Tate from Team 1 made for the item Pen. 

 

mailto:excelpunks@gmail.com


Essential Excel in a Day! 

 

Get in touch at excelpunks@gmail.com!  Page 95 

 

 

As you can see, the pivot table allows you to sort and retrieve values from a list using the ‘Report 
Filter’. 

Let’s try another example with ‘Row Labels’.  Move the data field ‘Unit Sales’ to the ‘Row Labels’ 
box. 
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Not much different from ‘Column Labels’ right?  The difference between ‘Column Labels’ and ‘Row 
Labels’ is in the way the data is represented.  Multiple ‘Column Labels’ will present the data in a row 
from left to right while multiple ‘Row Labels’ will present the data in a column from the top down. 

Let’s try this out.  Drag the data field ‘Name’ out of ‘Report Filter’ and back into the ‘Pivot Table Field 
List’.  Just click, hold and drag it. 

Now we see that the Row Labels have more numbers in it, 3, 4 and 9.  If you look at the ‘Report 
Filters’, you see that we have selected ‘Team 1’ and ‘Pen’. Comparing it with our data sample, we 
see that Team 1 has made 4 instances of sales for the item Pen, with unit sales of 3, 4, 4 and 9, just 
like in the Row Labels list.  But, the Row Labels only have 3 numbers – that’s right.  The Row Labels 
list acts as a list of labels, much in the same way at the Report Filters.  So, up till now, we see that 
‘Report Filters’ allows you to select categories of data and that ‘Row Labels’ and ‘Column Labels’ 
allow you to view the categories of your data. 
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Drag the ‘Unit Sales’ data field from the ‘PivotTable Field List’ to ‘Values’. 

See that ‘Unit Sales’ can exist in both ‘Row Labels’ and ‘Values’ at the same time?  Yes, it’s possible.  
Now we see another list appear called ‘Count of Unit Sales’.  This means that for Team 1, for the 
item Pen, there is 1 instance of a 3 unit sale, 2 instances of a 4 unit sale and 1 instance of a 9 unit 
sale. 
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You can change the settings of ‘Values’, by clicking on the dropdown arrow beside ‘Count of Unit 
Sales’ in the ‘Values’ box.  Select ‘Value Field Settings’. 
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Upon clicking on ‘Value Field Settings’, you will see this option box appear. 
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In the ‘Summarize by’ tab under ‘Summarize value field by’, you will see that you can select how you 
want the ‘Values’ box to compute the data.  Click on ‘Sum’ and then click ‘OK’. 

See that in our spreadsheet, ‘Count of Unit Sales’ has now become ‘Sum of Unit Sales’ and instead of 
listing the number of instances where a certain number of unit sales have occurred, the pivot table 
now computes the total amount of sales by multiplying the unit sales categories by the number of 
instances. 

Hence, 1 instance of a 3 unit sale becomes a total of 3 units sold, 2 instances of 4 unit sales becomes 
a total of 8 units sold and 1 instance of a 9 unit sale becomes a total of 9 units sold.  See also that the 
‘Grand Total’ has become 20, the total number of units sold, rather than 4 previously, which was the 
number of instances where a sale occurred. 
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5.2.2. Pivot Charts 

Example spreadsheet Pivot Chart.xlsx is included in the folder Lesson 5. 

Pivot charts make use of pivot tables to automatically generate charts from the data in your pivot 
table. 

Let’s try this out. 

To create a pivot chart, select the ‘Insert’ tab and then select ‘Pivot Table’.  In the dropdown menu 
provided, select ‘Pivot Chart’. 

 

An option box will appear.  Like a pivot table, this option box allows you to select the data you would 
like to place in your pivot chart. 

Let’s select the data from D1 to E8.  You would see that “Sheet1!$D$1:$E$8” appears in the 
‘Table/Range’ field. 

 

Click ‘OK’. 
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By clicking and dragging the fields ‘Item’ into ‘Axis Fields’ and ‘Unit Sales’ into ‘Values’ at the bottom 
right, we would gain this chart. 

 

You will notice that a lot of options available to you in a pivot table are also available in a pivot chart. 
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5.2.3. Data Validation 

Example spreadsheet Data Validation.xlsx is included in the folder Lesson 5. 

Data validation is a fancy term for customizing the content of a selected cell.  When you set a data 
validation setting in a cell, it rejects other types of input other than the type you have specified.  
Let’s see how this is done in Excel. 

Click on the cell that you want to place your data validation setting in and then click on the ‘Data’ tab 
and then select ‘Data Validation’ from the ‘Data Tools’ category.  

Then select ‘Data Validation’ again. 

 

This option box will appear. 

 

Click on the dropdown arrow under ‘Allow’ and you will see a list of options.  The ‘Allow’ field sets 
the type of data input for that cell.  You specify the kind or format of the data for this cell and once 
you’re done, the cell will reject data input in any other format. 
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5.2.3.1. ‘Any Value’ – that’s the default of any cell.  This means that you can input 
any value you want in the cell. 

5.2.3.2. ‘Whole Number’ – this means that you will be able to enter numerical values 
in the cell, but nothing with decimals. 

 
 
When you select ‘Whole Number’, you will be able to select settings for the range of 
data that can be entered into the cell. 

mailto:excelpunks@gmail.com


Essential Excel in a Day! 

 

Get in touch at excelpunks@gmail.com!  Page 106 

 

 
 
You can also set a range of values.  Anything outside of the range you specify will be 
rejected.  In this example, we set the minimum value at 1 and the maximum at 10, 
meaning that any value outside the range of 1 to 10 will be rejected by the cell. 
 
Remember, that as we selected ‘Whole Number’, all numbers with decimal places or 
fractions get rejected too. 
 

 

 

5.2.3.3. ‘Decimal’- allows numerical values with decimals. 
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This offers the same types of options as ‘Whole Number’. 

 

5.2.3.4. ‘List’ – allows you to specify a list of values and the cell will create a 
dropdown list of these values that you select.  No other inputs besides the values 
in the list will be accepted.  Exciting. 

Let’s create a List under Data Validation using our sample data.   

Select cell J2.  Our List under Data Validation will appear here. 

Remember to set a data validation setting in a cell, we click on the ‘Data’ tab and in the ‘Data Tools’ 
category, we select ‘Data Validation’ and then from that menu, we select ‘Data Validation’ again. 

 

The following option box will appear.  Select ‘List’ in the field ‘Allow’.  We will now fill in the ‘Source’ 
field.  The ‘Source’ field indicates from where we want our list of values to come from – the source 
of our titular list, so to speak. 
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Select cells D2 through to D8.  You will see that the following cells reference will appear in the 
‘Source’ field, like so. 

 

Click ‘OK’. 

Now, we have a dropdown list in cell J2 containing the items from cells D2 to D8. 
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You might have realised that Data Validation Lists can only be created from data that exists on the 
SAME worksheet.  What if you wanted to refer to data from ANOTHER worksheet?  That is possible. 

First, you will need to create a Named Range. 

Let’s copy all the names from Team 1, from cells B2 through to B11, from Sheet 1 to Sheet 2. 
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Now, select the list of names and then perform a right click with your mouse still pointing within the 
list. 

A menu will appear. Select ‘Name a Range’ from this menu. 
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As the list of names we just copied is still selected, we can immediately name this cell range, from A1 
to A10 on Sheet 2.  Normally, you would have to select a range of cells before you can Name a 
Range. 

This option box will appear. 
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In the ‘Name’ field, we can just type on any name we wish, as long as there are NO blanks between 
the text.  Let’s call our list ‘Namelist’. 

 

‘Scope’ refers to the applicability of our list.  Our selection here is ‘Workbook’, meaning that the list 
‘Namelist’ can be accessed throughout the whole workbook.  That’s what we want. 

Notice that the field ‘Refers to:’ contains the range of our name list, from cell A1 to A10?  This means 
that our list ‘Namelist’ will get its data from this cell range.   

Click ‘OK’. 

Now, we’ll return to Sheet 1.  Click on cell K2.  Create a List under Data Validation again, but this 
time, in the ‘Source’ field, type in =Namelist. 

Click ‘OK’. 
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Now, see that in cell K2, we have a dropdown list containing all the names of persons from Team 1. 

 

Nifty. 
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5.2.3.5. ‘Date’ – allows you to enter Date type data. 

 

5.2.3.6. ‘Time’ – allows entry of data in Time formats. 

 

 

5.2.3.7. ‘Text Length’ – allows you to specify a certain length of data that can be 
input.  Very useful if you are entering a large number of items with a set number 
of characters in a code format, so that you don’t miss anything. 
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5.2.3.8. ‘Custom’ – allows you to set a formula or a specific set of values that can be 
entered into the cell.  Anything else gets rejected. 

An example would be if you wanted the data input in this cell to be 5 
numbers long exclusively: 
=AND(ISNUMBER(A1),LEN(A1)=5)) 
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5.2.4. Charts 

Charts are a fairly simple affair.  In Excel, charts get their information from data that you select.  Let’s 
try it out. 

Select the ‘Insert’ tab and you will see a selection of chart types above the category called ‘Charts’.  
Let’s select a ‘Column’ chart.   

 

Now, we will select a ‘2-D Column’ chart.  Let’s go with the first one. 
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A box will now appear.  Notice that the ‘Design’ tab contains many of the options that pertain to 
your chart.  The other tab that affects your chart is the ‘Layout’ tab just to the right of your ‘Design’ 
tab. More on that later. 
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Now, click on the ‘Design’ tab and click on ‘Select Data’ in the ‘Data’ category.   

 

You can also just perform a right-click while your cursor is within the chart box and select ‘Select 
Data’.  They both do the same thing. 

 

Well, whichever method you choose, once selected, you will see this option box appear.  In the field 
named ‘Chart data range:’, you can enter the cell reference that contains your data by manually 
typing it in or clicking and dragging to select the whole range.  Remember to include the titles of 
your data in your selection.  
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Now, let’s select some data for our chart. 

Perform a left-click and drag over the cell range B1 to B11. 

 

Now, hold down the Ctrl key and then perform a left click and drag over cell range E1 to E11.  Notice 
that the two sections have been selected and have dotted lines bordering them. 
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Here, we’ve selected cell reference: =Sheet1!$B$1:$B$11,Sheet1!$E$1:$E$11.  Notice that it 
includes the titles ’Name’ and ‘Unit Sales’ and includes the data for Team 1.  The cell range looks 
complicated, but it is actually a composite of two ranges: 

=Sheet1!$B$1:$B$11, - that’s our name list 

Sheet1!$E$1:$E$11 – that’s the unit sales data 

 

Click ‘OK’. 

A chart has now automatically been created!   
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You can change the orientation of the chart by clicking on the button ‘Switch Row/Column’. This 
exchanges the row headers and column headers – just in case you want your data presented in a 
different way. 

 

Now, click ‘Switch Row/Column’ again to switch the headings for our next part.  Your chart should 
look like this. 

 

Adding a new series 

Step 1: 

You can add an additional item to the chart by clicking on the ‘Add’ button in the ‘Select Data 
Source’ option box, under ‘Legend Entries (Series)’. 
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Step 2: 

You will see an option box appear called ‘Edit Series’.   

 

Under ‘Series Name’ type =Sheet1!$F$1 or you can just click on the cell, which would cause this 
reference to appear ‘=Sheet1!$F$1’.   

Notice that cell F1 contains the title ‘Unit Cost Price’.  This is to be the title of our new data series to 
be added to our chart. 

 

Step 3: 
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Under the title ‘Series Values’ enter the cell reference for cells F2 to F11, like this 
=Sheet1!$F$2:$F$11.  The reference should look like this ‘=Sheet1!$F$2:$F$11’.  You can just click 
and drag to select the cell range too. 

Step 4: 

Now, click ‘OK’. 

 

Now, our chart has an additional data field added to it, the Unit Cost Price! 

 

 

Editing a Series 

Step 1: 

You can also edit the data in a series by going back to the ‘Select Data Source’ option box, selecting 
the series you want to change and clicking on ‘Edit’. 

Once you have selected a series, it will be highlighted in blue as shown below. 
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Remember that we can get to the ‘Select Data Source’ option box by performing a right-click within 
the chart and clicking on ‘Select Data’. 

 

 

Step 2: 

You will see an option box titled ‘Edit Series’.  In the field ‘Series Name’ you can either manually 
enter the cell reference the new name is in or just click on it.  In the field ‘Series Values’ you can 
enter manually the cell reference the new series’ values are contained in or you can click and drag to 
select them.  Notice the current values of the cells appear next to this box.  This is similar to Step 2 
and 3 when ‘Adding a new series’.  
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Currently, this data series corresponds to column E, which is the ‘Unit Sales’ of each salesperson. 
Let’s change this to the ‘Unit Sales Price’ data series. 

Step 3: 

Highlight the text in ‘Series name:’ and click on cell G1, which has the title ‘Unit Sale Price’.  The cell 
reference is =Sheet1!$G$1. 

 

Now, select cells G2 to G11 for ‘Series values:’ in a similar fashion.  Your ‘Edit Series’ box now looks 
like this. 

 

Click ‘OK’. 

Notice now that our chart shows the ‘Unit Cost Price’ and ‘Unit Sale Price’ for each salesperson 
instead of the ‘Unit Sales’.  You have just edited your chart’s data series! 
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Removing a series 

You can remove a series by clicking on the ‘Remove’ button.   

 

Notice that the data series ‘Unit Sale Price’ disappears. 
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Changing Title Labels 

Step 1: 

You can change the title of the chart by performing a left double click on the title.  A text box will 
appear and you can change the text as you wish. 

 

Tips: 

In the ‘Design’ tab, you can change the layout and style of the chart in the categories ’Chart Layouts’ 
and ‘Chart Styles’.  Purely aesthetic. 

There are host of other frills you can add to your chart in the ‘Layout’ tab.  In this case, we have 
added gridlines and error bars to the chart readings.  Makes for a more professional looking chart.  
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5.2.5. INDEX 

Example spreadsheet INDEX.xlsx is included in the folder Lesson 5. 

INDEX uses a cell reference you specify and returns you a value based on the coordinates you 
indicate.  In other words, INDEX gives you a value based on the relative location that you specify in a 
table of data.  Here’s an example: 

=INDEX(D1:E11,3,2) 

Let’s break that down.   

=INDEX(D1:E11 – this is the cell reference we want INDEX to look at.  We are telling INDEX to look 
within the reference D1 to E11 and to give us the value that occurs in the next 2 coordinates we 
specify. 

 ,3,2) – we have thus specified 3 and 2, separated by commas.  This tells INDEX to look within the 
cells from D1 to E11 and to give us the value in the 3rd row and in the 2nd column of the cell 
reference D1 to E11, which, as we can see, is the number 14. 
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5.2.6. MATCH 

Example spreadsheet MATCH.xlsx is included in the folder Lesson 5. 

MATCH is similar to INDEX except that it looks at a value or text you specify and returns its relative 
location in a table of data you specify.  It is a reverse of INDEX.  INDEX gives you a value based on co-
ordinates you specify, while MATCH gives you the co-ordinates of a value you specify. 

Here’s an example: 

=MATCH(B5,B3:B6,0) 

Let’s break this down. 

=MATCH(B5, - this indicates that you want MATCH to use the value in cell B5, which is the name 
‘Dan Edwards’ and give you its relative location in the next cell reference. 

B3:B6,0) – this means that the data you want MATCH to look at is from cell B3 to B6 and to match it 
EXACTLY, signified by the number 0.  The relative location of the name ‘Dan Edwards’ in the cell 
reference B3 to B6 is in the 3rd row, hence the answer of 3. 

Tip:  

We are able to combine the INDEX and MATCH functions to act as a sort of VLOOKUP function.  The 
following function allows you to match data using 2 criteria. 

=INDEX($M$8:$O$23,MATCH(J8,$M$8:$M$23,0)*MATCH(K8,$N$8:$N$23,0),3) 
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5.2.7. ROW/S 

Example spreadsheet ROW and ROWS.xlsx is included in the folder Lesson 5. 

ROW tells us which row a selected cell is in.  Now, this may seem like a silly thing, but ROW is used 
more often when you have huge amounts of data and want to relate data in combination function 
formulas. 

Here’s a simple example of how ROW works: 

=ROW(A6) 

Here, we’re checking which row the cell A6 is in, with our answer being 6, for row 6. 

 

ROWS works in very much the same way except it counts the number of rows in a cell range 
selection.  Here’s an example: 

=ROWS(A1:A10) 

Here, we’ve selected cell range A1 to A10 and ROWS counts the number of rows this cell range 
covers, the answer being 10. 
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5.2.8. COLUMN/S 

Example spreadsheet COLUMN and COLUMNS.xlsx is included in the folder Lesson 5. 

COLUMN, like ROW, tells us which column a selected cell is in. 

Here’s an example: 

=COLUMN(D2) 

Here, we’re checking which column cell D2 is in, with our answer being 4 for column 4. 

 

COLUMNS, like ROWS, counts the number of columns a cell range covers. Here’s an example: 

=COLUMNS(D1:G6) 

Here, we’ve selected cell range D1 to G6 and we want to find out how many columns this cell range 
covers.  Our answer is 4 for a total of 4 columns. 
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6. Final Project 

6.1. Overview 

The final project will test your ability to understand all the functions and concepts that have been 
discussed in this course.   

Create a database manager for the sample data consisting of: 

• At least 2 types of font and alignment formatting 

• A composite formula consisting of at least 2 functions; 1 text function and 1 mathematical 
function, that relates to information from the dropdown list 

• A VLOOKUP function  

• A dropdown list (data validation) 

• A pivot chart 

Your completion of the project would mean that you have acquired all the necessary skills to be a 
competent Excel operator. 

Learning never ends, though.  So, keep inventing and innovating!  Good luck! 

 

mailto:excelpunks@gmail.com

